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Developed By 

 

Contact Us 
Email support@xeostech.com 
Phone 1 (902) 444-7650 
Fax 1 (902) 444-7651 
Website www.xeostech.com 

 

Version History 
Version No. Date Description 

4.0 February 2018 Format overhaul for new iteration of site 

4.1 April 2018 Added new map option and Manuals button 

4.2 January 2019 Reflect various site changes 

5.0 January 2020 Overhaul to reflect site changes 

5.1 February 2020 Overview expanded 

5.2 November 2020 Changes to RUDICS section 
 

Regular checks for the latest manual are suggested. Be sure to check Xeos Technologies’ manuals 

page to compare versions and download the latest version. 
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https://manuals.xeostech.com/
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Overview 
XeosOnline™ is a web-based application that streamlines and facilitates the management of 

Iridium and cellular devices, and can be used to track, monitor and configure Xeos devices 

remotely. 

Users of XeosOnline are given a select space to house devices within which to command and 

control. Data from these devices can be viewed in part or whole in this space. Using XeosOnline’s 

forwarder system, select members of groups (Organization Administrators) can create mailing 

lists to distribute all, or a subset of data to individuals, regardless of the recipient. 

XeosOnline also has the added benefit of organizing device data for real-time analysis and export, 

as well as the ability to apply that data to an easy-to-use map system, where applicable, to 

visualize current environments and predict future positions of objects in motion. 
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User Level 
The User Level indicates that user’s privileges throughout the XeosOnline web portal. Each user 

level has the following scope in the group they inhabit: 

 Regular User 

o Can send commands, view, and download data from all devices 

 Organization Administrator 

o Can send commands, view, and download data from all devices. 

o Admin tab functionality to edit/delete device information 

o Can search device IMEIs through the site 

While users can be placed in multiple groups by Organization Administrators, new users can only 

be created by Xeos, and must use a valid email for login. 

Home Tab 
The Home view can be reached by clicking                        on the top right of XeosOnline, and is the 

first window that will appear upon logging in. For regular users, this will be the only main window. 

Devices Menu 
The Devices Menu displays all devices that have been added to an organization. 

 The Devices menu is also used to select devices for viewing Logs and Locations. 

 Any number of devices may be selected. 

 Select all devices of a type by using the checkbox by the Product Name. 

 Collapse the Devices Menu by clicking  
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Message Panel 

Map 
The Map tab displays a satellite map of current and past GPS fixes from the selected device. 

1. To navigate around the map, click and hold the left mouse button and drag the screen. 

Alternatively, the pan control can be used 

2. Zoom in and out using the scroll wheel on the mouse, or use the zoom control on the top-left 

of the map 

3. Users can also use Street View by dragging  onto the map  

 

 

4. To exit Street View, click the        in the top-right corner 

5. Users can switch between Map and Satellite overlays by using the                              control 

 The Satellite overlay displays real satellite images. Labels, such as 

street names, can be toggled by clicking the labels checkbox 

 The Map overlay displays basic map information. Terrain can be 

toggled on or off using the Terrain checkbox  

Alternative Map 

A secondary map option to the map tab that uses OpenStreetMaps and MapBox is available as 

an alternative to Google Maps. This option retains all the same features as the Google maps 

option along with some new filters that can be accessed in the top right-hand corner of the map 

window using the       button.   

Use the            button to switch maps at any time.  
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This setting will store the last map loaded as the default for the next login.  

 

Media 
Lists any media recordings created by the device. Files here can be downloaded for analysis. 

Event Log 
Any Events generated by a device are logged and displayed in this tab. To sort messages, click on 

a column header 

ID Generated for each individual record by the database 

Message ID Unique to each message from a device. Multiple log entries can reference 
the same Message ID 

Device Name assigned to the remote device that generated the message 

Date Processed Date and time from when XeosOnline received and processed a message 

Event Type Name assigned to an event, such as Power-up, Motion, Surfacing or an 
Alarm. 

Details The content of the message 

Filters 

 Logs can be filtered by clicking on     

 The user can enter a Date Range to filter the Event Log 

 

 Filtered or unfiltered Event Logs can be downloaded by clicking on a preferred file type 
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Location Log 
All messages pertaining to Location are displayed here. To sort messages, click on a column 

header 

ID Generated for each individual record by the database 

Message ID Unique to each message from a device. Multiple log entries can reference the 
same Message ID when sent at the same time 

Device Name assigned to the remote device that generated the message 

Timestamp Date and time taken from the Iridium message 

Latitude Latitude of the GPS message 

Longitude Longitude of the GPS message 

Uptime How long the device took to acquire the GPS position 

SNR The Signal to Noise ratio of the GPS reading, higher is better 

Sat Count Number of satellites used to acquire the GPS position 

Alarm Whether or not the message was generated by an alarm event 

Bearing Some devices can detect direction of motion, displayed as degrees from 
north 

Speed If a device can detect motion, this field displays speed in km/h, and knots 

HDOP Horizontal Dilution of position, lower is more accurate 
 

Filters 

 Location logs can be filtered by clicking     

 The user can enter a Date Range to filter the Location Log 

 

 Filtered or unfiltered Location Logs can be downloaded by clicking on a preferred file type 
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Message Log 
The Message Log Tab displays all messages sent to and from a device. To sort messages, click on 

a column header 

ID Unique to each message from a device. Multiple log entries can reference the 
same Message ID 

Device Name assigned to the remote device that generated the message 

Date 
Processed 

Date and time from when XeosOnline received and processed a message 

SBD Date Timestamp generated on reception by the Iridium network 

Direction Indicates whether a message was sent to a device (outgoing) or from a device 
(incoming) 

Message The parsed contents of the message 

Filters 

 RUDICS keep-alive messages can be filtered out by clicking  

 Message logs can be filtered by clicking     

 The user can enter a Date Range to filter Message Logs 

 

 Filtered or unfiltered Message Logs can be downloaded by clicking on a preferred file type 
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RUDICS Tunnels 
The RUDICS Tunnels tab displays the station details associated with any selected devices. This tab 

is only useful to devices capable of using a RUDICS tunnel. 

 

Station The name assigned to the station 

Active State Indicates whether this RUDICS station’s connection options can be utilized 

Connection 
State 

Indicates if a station is currently connected by a RUDICS tunnel 

IMEI The IMEI number of the device associated with this station 

Voltage Indicates the battery health of the device associated with this station. 

Temp The last temperature reading at the station 

Data Sum of data used by this device in bytes. 

Details Click the wrench for an in-depth view of a station’s health 

Station Health Details 

The Details section (inside the previous menu’s wrench) gives the user an in-depth view of a 

station’s statistics, as well as the ability to edit connection settings. 

 

Basic Information 

Name The Name assigned to this station 

Tunnel Listen Port The open port XeosOnline will use to listen for incoming RUDICS 
connections. 

Status Indicates if a station is able to start a connection (Active or Inactive) and if 
the station is currently connected to a tunnel (Connected or Disconnected) 
as on the above page. 

Last Connected The timestamp of the station’s last connection 

Last Disconnected The timestamp of the station’s last disconnection 

Status of Health 

Firmware Version The current firmware currently running on the device 

Battery Voltage The last recorded battery voltage of the device (in Volts) 

Last Temperature The last recorded temperature measured by the device (in degrees 
Celsius) 

Data Last 24 Data transferred over RUDICS in the last 24 hours 
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Tunnel Configuration 

Tunnels can run scripts for downloading or other actions over RUDICS on detection of an 

applicable connection. 

Connect Script Indicates if a script is enabled or disabled 

Script Filename Shows the path of the script to be implemented if enabled 

Tunnels 

Displays statistics logged for tunnels used by this station.  

Name The name assigned to the tunnel 

Local IP:Port Port of the XeosOnline Server used to “Tunnel” to the peripheral device. 
The IP portion is non-editable. 

Remote IP:Port IP:Port of the peripheral device to be “Tunneled” to through the RUDICS 
device 

Protocol The protocol used by the tunnel’s connection (UDP or TCP) 

Status Current ability to use this particular tunnel connection 
 

Exporting Data 
The export selection feature allows the user to download a file containing all log entries of a 

specific category for currently selected units. 

1. Data can be quickly downloaded by selecting the device to pull, then navigating to the 

relevant tab containing the data to export. 

 

2. At the bottom of the tab are two buttons, CSV and Excel. Clicking these buttons downloads 

the currently displayed messages in .csv or .xslx format, respectively. It should be noted that 

the date filter in this section can be used to download a specific timeframe of messages, or 

choose the Show All Messages button to download all messages for a device. 

 

Note: If more than one device is selected at the time of download, messages from both 

devices will be mixed in order of date and time. 
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Main Menu 
The top left of the Home Tab lists several different options for 

interaction, whether that be for interaction with devices or the user’s 

account. 

Once a user has been created, an administrator may add that user to 

another organization through the Admin tab. 

Sending an Iridium Message 
The Send Command dialog provides users with a convenient way to 

send messages to any number of devices within their organization. 

1. Users can send an SBD (Short Burst Data) message to any device within the scope of their 

organization by going to File → Send Command 

2. The Send Message dialog will appear 

3. Select the device to receive the SBD message and click           

 Multiple devices can be selected by holding  

 Click     to add all devices 

 Click        to remove a device from the intended target list, or click         to remove 

all devices 

 Devices can also be dragged and dropped from one side of the window to the 

other 

 
4. SBD Commands can be typed into the Commands box. For more information on device 

commands, consult the device’s manual. 



 

XeosOnline Manual 5.2  13  

Note: Some devices (as noted in their manuals) require an Unlock Code before all commands. 

XeosOnline saves this unique code for each device if it has been received previously and adds it 

ahead of any outgoing commands.  

If the outgoing command is prefixed with $Unlock 0 in the message log, XeosOnline does not 

have this code. The intended command will be ignored by the device; it will reply with the correct 

code on the next Iridium check, provided XeosOnline is set to receive the device’s messages. 

 
 

5. Target Lists and/or Commands can be saved as templates for later use. Saved templates can 

be loaded from the Saved templates list. 

6. Once the Target List and Commands are ready, click  .   The target devices will 

process the command during their next Iridium Check. Outgoing messages are logged in the 

Message Log tab. 
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Options 

Time Zone 
When the user’s time zone is changed, all messages and message logs will display in local time. 

1. Select Menu → Options 

2. The Options dialog will appear.  

 

3. From the Time Zone list, select the desired Time Zone. 

4. Click and the new time zone will be applied immediately. 
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Hide Tabs 
Tabs not used by the user can be hidden. This setting is retained to the user through logins. 

1. Select Menu → Options 

2. The Options dialog will appear.  

 

3. Select the tabs to hide 

4. Click     and the new tab setup will be applied through a refresh. 

 

Change Password 
A user may wish to change their password; this can be done through the options menu. 

1. Select Menu → Change Password 

2. The Change Password dialog will appear   

 

3. Enter the new password and press                          Log out to finalize the change. 

 

It should be noted that users that forget their password can use the Forgot Password utility on 

the login page. 
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Search Device 
The search device option allows a user to find any device by IMEI number. If the device already 

exists on the system (may be in a testing area) the results will be found here. This is an 

Organization Admin only feature. 

1. Select Menu → Search Device 

2. The Search Device dialog will appear. 

3. Enter the IMEI of the device to find and click 

 

Results for the search will appear, listing the name of the device in the system, and a list of all 

Organizations to which the device is a member. 

Manuals 
Users can find a link to all the latest manuals pertaining to Xeos products using the         …………….     

button on the top-right of the screen. Clicking this button will open a new tab in the browser. 
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Admin 
The Admin button gives the Organization Administrators access to the administration pane. From 

there, the Admins can configure XeosOnline options such as: Devices, Forwarders and 

Organizations. 

To access the Administration Pane, simply click the                   button on the top right of the 

page. 

Devices Tab  
The Devices tab contains statistics and settings related to the devices in the currently selected 

Organization. 

Columns 

Name 

The Name column lists all devices in the currently selected organization. The devices are sorted 

by product type 

Options 

The Options column allows the user to edit or delete individual devices; see below 

Delete Device  
Clicking on the Delete Device button will completely remove the device from XeosOnline. All 

data related to this device will be erased.  

Edit Device  
Clicking the Edit Device button will bring up the Device dialog 
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Device Dialog 

Device Shows the device’s Product Type (Set when adding a new device) 

Organizations Allows an admin to assign the device to any organization to which 
that person belongs. Devices can exist in any number of 
organizations. 

 

Enabled Allows (Enabled) or restricts (Disabled) the sending of outgoing 
commands to this device. 

Name The name of the device as shown on the Home Tab and Device menu 

Notes stores relevant additional information for this device 

IMEI displays the devices SBD IMEI number 

Incoming SBD Allows the user choose the source for the device’s SBD messages 

Latitude/ 
Longitude 

Can be used to show the devices deployment location. Must be set 
manually for device types that do not have GPS systems. 

DISA Specifies to XeosOnline if the device is using the DOD network; 
commands to devices will then send to the correct destination. If a 
DoD modem is not being used, leave this setting as Disabled. 
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Forwarders Tab 
The Forwarders tab allows users to send device messages to individual emails. Forwarders can 

be customized to include several devices as well as multiple recipient emails. It should be noted 

that recipients of these emails are not required to be users of XeosOnline. Therefore, any number 

of recipients can be set to receive messages to quicken response to appropriate events. 

Creating a Forwarder 
1. To create a forwarder, click on  

2. The Forwarder dialog will appear 

3. Forwarder Type will present several options from a drop-down menu: 

Alarm Email Forwarder Will forward all alarms to included targets.  

All Email Forwarder Forwards all SBD messages to included targets 

To Shout Forwarder Forwards SBD messages to a Nano Shout handheld 
Iridium device 

STI Event Forwarder (STI40x) Forwards STI Events to included targets 

Audio Forwarder Forwards Audio Recordings from Sentinel units 

Sentinel Plain Text Forwarder Forwards SBD messages from Sentinel units 

Simple ASCII Position Forwarder Forwards GPS Fixes to included targets in text format 

Simple ASCII Position Forwarder 
w/Battery Voltage 

Forwards GPS Fixes, as well as current battery voltage 
of the device in text format 

Hermes Forwarder Forwards Xeos Beacon positions to the Hermes 

4. Name: Give the Forwarder a meaningful name 

5. Description: Record any additional details about the Forwarder 

6. Limit: The number of forwarded messages the target will receive can be limited. If no limit is 

required, leave at Zero Forwards. 

Adding Devices and Targets to Forwarders 

Once a Forwarder has been created, devices and targets can be added. 
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1. Select a Forwarder from the list. 

 

2. Click                    and the Source Devices tab will appear. Select the devices to forward. 

 

3. Click                    again, email targets can be created and selected. 

 

 

 

4. To add recipients to the Forwarder, use the                  button and add the recipient’s name 

and email address. Check off any individuals in the list to receive forwarded messages. 

5. Click              The prompt to save the additions to appears.  Additionally, the Test 

Forwarder button will send a test message to all checked recipients. 
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Organizations 
The Organizations Tab lists all spaces that the user has access to. From here, user credentials can 

be modified, added or deleted.  

The system administrator has the sole authority to create new users, Organization Administrators 

can move existing users between different groups. 

Add User 

1. The Add User Dialog will appear 

2. Begin typing the name of the user to add to the Organization 

3. Select the user to add from the list of users 

4. Grant that user an access level, for more information see Users 

Edit Organization 
The Edit Organization dialog will appear; from here, the name of the Organization can be 

changed. 

Users 
Organization Administrators can manage the privileges of users within their scope, as well as 

delete users. 

Delete 

When deleting a User from an Organization, an alert will appear. Press OK to confirm the action. 

Edit 

 

Clicking the Edit User button brings up the Organization User Dialog.  Administrators may then 

choose a new User Level for that user within an Organization 
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Terms of Service and Private Policy 
By using the Xeos site, you are agreeing with the following terms and privacy policy.  

To make sure that the content and services Xeos provides to you are of the highest possible 

quality, we have developed this Terms of Service and Privacy Policy.  

Terms of Service ("TOS") 
1. Acceptance of Terms  

Xeos provides its website service to you, subject to the following Terms of Service ("TOS"), which 

may be updated by us from time to time without notice to you. You can review the most current 

version of the TOS at any time at: www.xeostech.com. In addition, when using particular Xeos 

services, you and Xeos shall be subject to any posted guidelines or rules applicable to such 

services which may be posted from time to time. All such guidelines or rules are hereby 

incorporated by reference into the TOS. 

2. Description of Service  

Xeos currently provides users with access to XeosOnline (the "Service"). Unless explicitly stated 

otherwise, any new features that augment or enhance the current Service shall be subject to the 

TOS. 

3. Your obligations as a user 

In consideration of your use of the Service, you agree to: (a) provide true, accurate, current and 

complete information about yourself as prompted by the Service's registration form (such 

information being the "Registration Data") and (b) abide by the TOS. Xeos has the right to 

suspend or terminate your account and refuse any and all current or future use of the Service (or 

any portion thereof). 

4. Account, password, and security  

You select a username and password upon completing the Service's registration process. You are 

responsible for maintaining the confidentiality of your password and are fully responsible for all 

activities that occur under your password. Xeos cannot and will not be liable for any loss or 

damage arising from your failure to comply with this Section. 

5. Conduct  

You agree to not use the Service to: 

1. Impersonate any person or entity, or falsely state or otherwise misrepresent your 

affiliation with a person or entity;  

2. Interfere with or disrupt the Service or servers or networks connected to the Service, or 

disobey any requirements, procedures, policies or regulations of networks connected to 

the Service;  



 

XeosOnline Manual 5.2  23  

3. Intentionally or unintentionally violate any applicable local, state, provincial, national or 

international law; 

You agree that you must evaluate, and bear all risks associated with, the use of any Content, 

including any reliance on the accuracy, completeness, or usefulness of such Content. In this 

regard, you acknowledge that you may not rely on any Content created by Xeos. 

6. International Use  

Recognizing the global nature of the Internet, you agree to comply with all local rules regarding 

online conduct and acceptable Content. Specifically, you agree to comply with all applicable laws 

regarding the transmission of technical data exported from the United States or the country in 

which you reside. 

7. Indemnity  

You agree to indemnify and hold Xeos, and its affiliates, officers, agents, co-branders or other 

partners, and employees, harmless from any claim or demand, including reasonable attorneys' 

fees, made by any third party due to or arising out of, your violation of these terms of service, or 

your violation of any rights of another. 

8. Links  

The Service may provide, or third parties may provide, links to other World Wide Web sites or 

resources. Because Xeos has no control over such sites and resources, you acknowledge and 

agree that Xeos is not responsible for the availability of such external sites or resources, and does 

not endorse and is not responsible or liable for any Content, advertising, products, or other 

materials on or available from such sites or resources. You further acknowledge and agree that 

Xeos shall not be responsible or liable, directly or indirectly, for any damage or loss caused or 

alleged to be caused by or in connection with use of or reliance on any such Content, goods or 

services available on or through any such site or resource. 

9. General Information 

These Terms of Service constitute the entire agreement between you and Xeos, and govern your 

use of the Service, superseding any prior agreements between you and Xeos. You also may be 

subject to additional terms and conditions that may apply when you use affiliate services, third 

party content or third-party software. The TOS and the relationship between you and Xeos shall 

be governed by the laws of the Province of Nova Scotia. You and Xeos agree to submit to the 

personal and exclusive jurisdiction of the courts located within the City of Halifax, Nova Scotia. 

The failure of Xeos to exercise or enforce any right or provision of the TOS shall not constitute a 

waiver of such right or provision. If any provision of the TOS is found by a court of competent 

jurisdiction to be invalid, the parties nevertheless agree that the court should endeavor to give 

effect to the parties' intentions as reflected in the provision, and the other provisions of the TOS 

remain in full force and effect. You agree that regardless of any statute or law to the contrary, 
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any claim or cause of action arising out of or related to use of the Service or the TOS must be filed 

within one (1) year after such claim or cause of action arose or be forever barred. The section 

titles in the TOS are for convenience only and have no legal or contractual effect. 

10. Modifications to Service  

Xeos reserves the right at any time and from time to time to modify or discontinue, temporarily 

or permanently, the Service (or any part thereof) with or without notice. You agree that Xeos 

shall not be liable to you or to any third party for any modification, suspension or discontinuance 

of the Service. 

11. Termination 

You agree that Xeos, in its sole discretion, may terminate your password, account (or any part 

thereof) or use of the Service, and remove and discard any Content within the Service, for any 

reason. Xeos may also in its sole discretion and at any time discontinue providing the Service, or 

any part thereof, with or without notice. You agree that any termination of your access to the 

Service under any provision of this TOS may be affected without prior notice and acknowledge 

and agree that Xeos may immediately deactivate or delete your account and all related 

information in your account and/or bar any further access to the Service. Further, you agree that 

Xeos shall not be liable to you or any third party for any termination of your access to the Service. 

12. DISCLAIMER OF WARRANTIES  

YOU EXPRESSLY UNDERSTAND AND AGREE THAT: 

1. YOUR USE OF THE SERVICE IS AT YOUR SOLE RISK. THE SERVICE IS PROVIDED ON AN "AS 

IS" AND "AS AVAILABLE" BASIS. XEOS EXPRESSLY DISCLAIMS ALL WARRANTIES OF ANY 

KIND, WHETHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED 

WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-

INFRINGEMENT, EXCEPT AS SPECIFICALLY STATED ELSEWHERE.  

2. XEOS MAKES NO WARRANTY THAT (i) THE SERVICE WILL MEET YOUR REQUIREMENTS, (ii) 

THE SERVICE WILL BE UNINTERRUPTED, TIMELY, SECURE, OR ERRORFREE, (iii) THE 

RESULTS THAT MAY BE OBTAINED FROM THE USE OF THE SERVICE WILL BE ACCURATE OR 

RELIABLE, (iv) THE QUALITY OF ANY PRODUCTS, SERVICES, INFORMATION, OR OTHER 

MATERIAL PURCHASED OR OBTAINED BY YOU THROUGH THE SERVICE WILL MEET YOUR 

EXPECTATIONS, AND (V) ANY ERRORS IN THE SOFTWARE WILL BE CORRECTED.  

3. ANY MATERIAL DOWNLOADED OR OTHERWISE OBTAINED THROUGH THE USE OF THE 

SERVICE IS DONE AT YOUR OWN DISCRETION AND RISK AND THAT YOU WILL BE SOLELY 

RESPONSIBLE FOR ANY DAMAGE TO YOUR COMPUTER SYSTEM OR LOSS OF DATA THAT 

RESULTS FROM THE DOWNLOAD OF ANY SUCH MATERIAL.  

4. NO ADVICE OR INFORMATION, WHETHER ORAL OR WRITTEN, OBTAINED BY YOU FROM 

XEOS OR THROUGH OR FROM THE SERVICE SHALL CREATE ANY WARRANTY NOT 

EXPRESSLY STATED IN THE TOS. 
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13. LIMITATION OF LIABILITY  

YOU EXPRESSLY UNDERSTAND AND AGREE THAT XEOS SHALL NOT BE LIABLE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, SPECIAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES, INCLUDING BUT 

NOT LIMITED TO, DAMAGES FOR LOSS OF PROFITS, GOODWILL, USE, DATA OR OTHER 

INTANGIBLE LOSSES (EVEN IF XEOS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES), 

RESULTING FROM: (i) THE USE OR THE INABILITY TO USE THE SERVICE; (ii) THE COST OF 

PROCUREMENT OF SUBSTITUTE GOODS AND SERVICES RESULTING FROM ANY GOODS, DATA, 

INFORMATION OR SERVICES PURCHASED OR OBTAINED OR TRANSACTIONS ENTERED INTO 

THROUGH OR FROM THE SERVICE; (iii) UNAUTHORIZED ACCESS TO OR ALTERATION OF YOUR 

TRANSMISSIONS OR DATA; (iv) STATEMENTS OR CONDUCT OF ANY THIRD PARTY ON THE 

SERVICE; OR (v) ANY OTHER MATTER RELATING TO THE SERVICE. 

14. Violations  

Please report any violations of the TOS to us.  

Privacy Policy  
By visiting our site at www.xeostech.com, you are accepting the practices described in this 

privacy notice.  

1. What does this privacy policy cover?  

This Privacy Policy covers Xeos treatment of personally identifiable information that we collect 

when you are on the Xeos site, or when you use Xeos' services.  

2. Information Collection and Use  

Xeos collects personally identifiable information when you register.  

When you register with Xeos, we ask for your name, email address, city, state/province, and 

country, as well as other optional information. Once you register with Xeos and sign in to our 

services, you are not anonymous to us.  

Xeos also automatically receives and records information on our server logs from your browser 

including your IP address, Xeos cookie information and the page you requested.  

Passwords are never divulged except to registered users directly upon verification.  

Xeos uses information for two general purposes: to fulfill your requests for certain services, and 

to contact you when you request it.  

We protect against loss of information by having regular backups of data. We keep up with 

current standards to protect against theft of data, and regularly apply security updates and 

patches to ensure we are using the latest software available to protect our servers.  

3. Information Sharing and Disclosure  
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Xeos will not sell or rent your personally identifiable information to anyone.  

Xeos may send personally identifiable information about you to other companies or people 

when:  

 We have your consent to share the information;  

 We are operating a web site in partnership with them and they wish to contact their 

members;  

 We need to share your information to provide the product or service you have requested; 

 We respond to subpoenas, court orders or legal process; or 

 We find that your actions on our web sites violate the Terms of Service or any of our usage 

guidelines for specific services. 

4. Cookies 

Xeos may set and access Xeos cookies on your computer, used to identify your user account and 

to allow for the proper functioning of the Xeos web site and accompanying services. 

5. Changes to this Privacy Policy  

Xeos may amend this policy from time to time. If we make any substantial changes in the way we 

use your personal information we will notify you by posting an announcement as a rotating 

spotlight and/or similar method on our home page. 

6. Personal Information Protection and Electronic Documents Act (PIPEDA)  

In compliance with Canadian Law, if you have any questions, comments or complaints about how 

we use your information, please contact our Privacy Officer.  

Contact: Privacy Officer  

Via letter mail: 36 Topple Drive, Dartmouth, Nova Scotia, Canada  

Via telephone: +1 (902) 444-7650  

Via email: itadmin@xeostech.com 


